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Chapter 1: Introduction
Welcome to xMatters (data load) engine for BMC Remedy ITSM. This document describes how to install and
configure the xMatters (data load) engine for BMC Remedy ITSM software integration. The intended audience for
this document is experienced consultants, system administrators and other technical readers.

About xMatters
xMatters is an interactive alerting application, designed to capture and enrich important events, to route those events
to the right person on any communication device, and to give that person the ability to solve, escalate, or enlist
others to resolve the events remotely.

xMatters allows you to take critical business information and contact the right people via voice phone, SMS, two-
way pagers, instant message, and email.

Through relevance engines, xMatters can become the voice and interface of an automation engine or intelligent
application (the Management System, such as BMC Remedy). When BMC Remedy detects something that requires
attention, xMatters places phone calls, sends pages, messages, or emails to the appropriate personnel, vendors or
customers.

xMatters is also persistent, escalating through multiple devices and personnel until someone accepts responsibility or
resolves the problem. Once contacted, xMatters gives the notified person instant two-way communication with BMC
Remedy. Responses are executed immediately on BMC Remedy, enabling remote resolution of the event.

1.1 Integration Summary
This integration provides a way to load Group and User data from BMC Remedy into an xMatters deployment.
While intended primarily as an enhancement to an existing xMatters for BMC Remedy integration, the data load
functionality provided by this integration can be installed as a stand-alone tool to synchronize data between BMC
Remedy and xMatters.

1.1.1 Benefits
The xMatters (data load) engine for BMC Remedy ITSM integration enables you to synchronize your data between
BMC Remedy and xMatters in two ways:

l When you create, update, or delete a User or Group in BMC Remedy, the integration automatically updates
the corresponding User or Group in xMatters.

l Running a batch data load synchronizes the current users and groups in BMC Remedy with xMatters.

The integration also sends a status notification of the data load result to a User in xMatters. The benefit is that the
synchronization is automatic; there is no need to maintain a manual process for updating user and group data across
two systems.

1.2 Integration architecture
The software components in this integration include:

l xMatters relevance engine
l BMC Remedy
l xMatters integration agent
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The data load integration service runs in the integration agent and performs data load operations in response to changes to
BMC Remedy users and groups, and batch data load requests. The integration involves the following steps each time you
create, delete, or update a user or group within BMC Remedy:

1. BMC Remedy triggers one of the xMatters filters provided as part of the integration.
2. The filter sends a SOAP web service request to the integration service.
3. The integration service processes the request, using web services to obtain information about the changed object.
4. The user and group information is loaded into xMatters via a series of web service calls.
5. xMatters sends a notification to a User with the status of the data load.

The integration performs batch data load operations in the same manner, except that the SOAP web service request is sent to
the integration service as a result of saving an instance of the XM:Event Injection form with an Action of "load".

1.2.1 Data load workflow
The following table describes the interaction between BMC Remedy and xMatters during the course of a typical data load:

BMC Remedy process Details xMatters process

User/Group Created A new user or group is created. The information is pushed to xMatters

User/Group Updated User/group information is changed (such
as name, contact info, or description).

The updates are pushed to xMatters

User/Group Deleted User/group information is marked for
deletion.

The related User/Group is removed from xMatters.

Note: Deletions are only performed during dynamic
data load. Batch data load does not delete Users or
Groups from xMatters.

Note that the above table identifies the behavior of the default installation configuration. The integration is highly
customizable, and can be configured to suit your specific deployment requirements.

1.2.2 Custom web services
The integration service relies on a set of custom web services implemented in BMC Remedy to access information about and
update users and groups. Extending or modifying the behavior of the integration service will also typically require a change
to the custom web services.

The integration service uses the following custom web services:

n XM_CTM_People_WS: exposes the fields belonging to CTM:People that can be used to create an xMatters User.
n XM_CTM_Support_Group_Association_WS: exposes CTM:Support Group Association; specifically, this web service

exposes the Login ID of all members of the group specified in the Qualification. The Qualification can also be used to
further limit which group members are returned, which should be a list of those members that will be made members of
the corresponding xMatters Group.

n XM_CTM_Support_Group_WS: exposes the fields belonging to CTM:Support Group that can be used to create an
xMatters Group.

n XM_CTM_SupportGroupFunctionalRole_WS: exposes the fields in CTM:SupportGroupFunctionalRole that can be
used to obtain Support Group Functional Role data that can then be mapped to Roles in xMatters.

1.2.3 Integration filters
This section identifies and describes the filters provided by the integration to enable the workflow explained in "Data load
workflow" on page 2.
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n XM:Group_Add_600: Runs when a new instance of CTM:Support Group is created.
n XM:Group_Delete_600: Runs when the Status field of a CTM:Support Group record is set to Delete.
n XM:Group_Update_600: Runs when an instance of CTM:Support Group is modified and the Status field does not

have a value of Delete
n XM:GroupMember_Add_600: Runs when an instance of CTM:Support Group Association is created or modified, the

Support Group ID field is not null, and the Status field is set to Enabled.
n XM:GroupMember_Delete_600: Runs when an instance of CTM:Support Group Association is deleted and the

Support Group ID field is not null.
n XM:GroupMember_Update_600: Runs when an instance of CTM:Support Group Association is modified, the Support

Group ID field is not null, and the field Assignment Availability is set to Yes.
n XM:Person_Add_850: Runs when an instance of CTM:People is created.
n XM:Person_Delete_850: Runs when an instance of CTM:People is modified and the field Profile Status has a value of

Delete.
n XM:Person_Update_850: Runs when an instance of CTM:People is modified and the field Profile Status does not have

a value of Delete.

1.2.4 Integration forms
This section identifies and describes the forms provided by the integration to enable the workflow explained in "Data load
workflow" on page 2.

XM:Event Injection
The XM:Event Injection form is the staging area for sending events to the integration agent. Each event includes a BMC
RemedyID which can be used to query for more information using web services and an Action keyword that describes what
should be done in xMatters. The available actions are:

l Add: creates a new User/Group/ in xMatters
l Update: modifies an existing User/Group in xMatters
l Delete: deletes an existing User/Group from xMatters
l Load: initiates a batch load of user/group information to xMatters. Note: no BMC Remedy ID is required for this

action.

The BMC Remedy ID is used to determine whether the Add/Update/Delete should be performed on a user:PPL or group:SGP.

The XM:Event Injection form is configured with a default Archive scheme to delete any XM:Event Injection instances after
seven days:
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XM:Action
This form is based on SYS:Action, and is used to separate the transactions of the BMC Remedy workflow from the workflow
of sending event information to xMatters.

1.3 System Requirements
The following products must be installed and operating correctly prior to integration.

xMatters:

l xMatters relevance engine 4.1 (patch 011 or later) or 5.x
l xMatters integration agent 4.1 (patch 005 or later) or 5.x
l xMatters Developer IDE

Note that the version number of the xMatters integration agent, xMatters relevance engine, and xMatters Developer IDE must
be the same. For example, if you are using the 4.1 version of the integration agent, then you must also use the 4.1 version of
the xMatters relevance engine.

BMC Remedy:

l BMC Remedy 7.5 through 7.6.04 (Service Pack 2)
l BMC Remedy Mid Tier
l BMC Remedy Action Request System

1.3.1 Operating Systems
The following component versions, operating systems and databases are supported by this integration.
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Integration Component Version Operating System Database

xMatters relevance engine 4.1 patch 011 Linux CentOS 5.3

Microsoft Windows 2008 (validated)

Oracle 11g

Microsoft SQL
Server 2008

5.0 Linux CentOS 5.3 (validated) Oracle 11g
(validated)

xMatters integration agent 4.1 patch 005 Linux CentOS 5.3

Microsoft Windows 2008 (validated)

5.0 Linux CentOS 5.3 (validated)

BMC Remedy 7.5 through 7.6.04
(Service Pack 2)

Microsoft Windows 2008 (validated with
Microsoft SQL Server 2008)

All operating systems supported by the
xMatters integration agent

Note: xMatters version 5.0 is currently available only for Linux/Oracle deployments. The integration agent is supported
on multiple platforms.

For more information about the supported operating systems for xMatters, refer to the xMatters installation and
administration guide and xMatters integration agent guide.

1.4 Conventions and Terminology
This section describes how styles are used in the document, and provides a list of definitions.

1.4.1 Conventions
Some instructions appear in the following format: MENU > OPTION; for example, File > Open means click the File menu,
and then click the Open menu option.

Words in bold typically reference text that appears on the screen. Words in monospace font represent the following:

l text that must be typed into the computer
l directory and file names
l code samples

Directory paths
Except where explicitly stated, the directory paths in this document are listed in Windows format. Unix users must substitute
the given paths with the Unix equivalents.

The xMatters installation folder is referred to throughout the documentation as <xMHOME>.

l On Windows systems, the default for the 4.1 version of xMatters is C:\Program
Files\AlarmPointSystems\AlarmPoint;for the 5.0 version, the default is C:\Program Files\xMatters\

l On Unix systems, the default for the 4.1 version of xMatters is /opt/alarmpointsystems/alarmpoint; for the 5.0
version, the default is /opt/xmatters/
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The xMatters integration agent installation folder is referred to throughout the documentation as <IAHOME>.

l On Windows systems, the default is C:\Program Files\AlarmPointSystems\IntegrationAgent for the 4.1
version, and C:\Program Files\xmatters\integrationagent for the 5.0 version.

l On Unix systems, the default is /opt/alarmpointsystems/integrationagent for the 4.1 version, and
/opt/xmatters/integrationagent for the 5.0 version.

1.4.2 Terminology
The following terms are used through the xMatters documentation.

Term Meaning

Event An event refers to any situation or item of interest detected by the management system, and which
requires attention. Event is also used to refer to the incident or situation as it progresses through the
xMatters system, from injection to notification to resolution. Each event must generate at least one
alert or notification.

Event can also be a generic term used to refer to an incident, change request, message, or other
specific item within the management system. Whenever possible, these situations are referred to
using the management system's preferred terminology (i.e., incident), but can also collectively be
called events.

Management system A management system is any sort of IT service management software, and with which xMatters can
combine; i.e., a synonym for BMC Remedy.

Device The medium through which a recipient is contacted by xMatters; i.e., email, pager, phone,
BlackBerry, etc.

User In xMatters, people who can receive notifications are called "Users". Each person in the xMatters
system is defined by a set of User details, including ID number, user name, login password, and so
on.

Group Groups are used to collect and organize Users and Devices into notification schedules. For a
complete explanation of Groups in xMatters, see the xMatters user guide.

Documentation terminology
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Chapter 2: Installation and Configuration
This chapter provides information about installing the xMatters (data load) engine for BMC Remedy ITSM integration. This
chapter also contains complete instructions on how to configure xMatters, BMC Remedy, and the integration components.

2.1 Installing the integration
This section describes the installation process for the xMatters (data load) engine for BMC Remedy ITSM integration.

Components
This integration includes the following components that must be modified for each deployment:

Component Name Description

bmcremedydataload.xml,
configuration.js

The JavaScript and XML service configuration file that defines the integration
service on the integration agent.

2.1.1 Installing the integration service
To install the integration service, you must perform the following steps:

l Copy the folder containing the integration components into the integration agent; this process is similar to patching the
application, where instead of copying files and folders one by one, you copy the contents of a single folder directly
into the integration agent folder (<IAHOME>). The folder structure is identical to the existing integration agent
installation, so copying the folder's contents automatically installs the required files to their appropriate locations.
Copying these files will not overwrite any existing integrations.

l Modify the integration agent's IAConfig.xml file to include the path for the new integration service.
l Modify the variables in the configuration.js file associated with the integration service.

If you have more than one integration agent providing the BMC Remedy service, repeat the following steps for each one.

Installing with other BMC Remedy integrations
If you are installing the xMatters (data load) engine for BMC Remedy ITSM integration on an integration agent that has a
BMC Remedy integration already installed, note the following considerations:

This integration comes with a copy of the integrationservices\bmcremedy\lib folder and the
integrationservices\bmcremedy\util.js which are the same as those bundled with the xMatters for BMC Remedy
Change Management and xMatters for BMC Remedy Incident Management integrations. If you have not customized any of
the files in integrationservices\bmcremedy\lib or the util.js file, then the installed files can be safely overwritten by
the ones included with this integration. If you have customized any of these files, do not overwrite the existing files. You
will need to compare your customized files with the ones included with this integration, determine whether your changes
will affect the integration, and merge your changes as necessary.

To install the integration service:

1. Copy all of the contents of the \components\integration-agent folder from the extracted integration archive to the
<IAHOME> folder.

2. Open the IAConfig.xml file found in <IAHOME>\conf and add the following line to the “service-configs” section:
<path>bmcremedy/bmcremedydataload/bmcremedydataload.xml</path>

3. Open the configuration.js files (now located in the
<IAHOME>\integrationservices\bmcremedy\bmcremedydataload folder), and set the values for the following
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variables:

Variable Description

MID_TIER_HOSTNAME Name of IP address of the network host on which the BMC Remedy web
services are running.

MID_TIER_PORT Port on which the BMC Remedy web services are running.

REMEDY_SERVER_NAME The name of the BMC Remedy server hosting the web services.

XM_CTM_WS_USERNAME User name of the account used to access the BMC Remedy web services
that support the integration.

XM_CTM_WS_PASSWORD_FILE Location of the file containing the web services user's password; for
instructions on how to set the password for this user, see "Setting web
services user password", below.

4. Save and close the files.
5. Restart the integration agent.

l On Windows, the integration agent runs as a Windows Service; on Unix, it runs as a Unix daemon.

Setting web services user password
This integration includes an encrypted file, located in the <IAHOME>\conf folder, that stores the password for the web
services user required for the management system. You will need to update the file with the correct password for the XM_
CTM_WS_USERNAME variable specified in the bmcremedydataload\configuration.js file.

Password file name:

l xm_ctm_ws.pwd stores the password for the XM_CTM_WS_USERNAME user used by the bmcremedydataload
integration service. If you change the name of this file, you must also update the configuration.js file to point to
the correct password file.

To specify a web service user password:

1. Open a command prompt, and then navigate to <IAHOME>\bin.
2. Run the following command, where <new_password> is the password for the web services user specified in the

configuration.js file, <old_password> is the existing password (the default value for a newly installed integration
is "password"), and <filename> is the name of the password file (xm_ctm_ws.pwd).

iapassword.bat --new <new_password> --old <old_password> --file conf/<filename>.pwd

2.2 Configuring BMC Remedy
Configuring BMC Remedy to combine with xMatters requires the following steps:

l Import the workflow definition files
l Configure filters
l Configure the ITSM user

2.2.1 Importing workflow definition files
The workflow described in this document is provided in definition files that must be imported into BMC Remedy.

Note that this integration provides two versions of the definition files: one version, marked with pre7604 is for BMC
Remedy versions 7.5 to 7.6.03, and the other version, marked with 7604, is for BMC Remedy version 7.6.04. These files are
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contained in the bmcremedy and bmcremedy/pre7604 folders in the extracted integration archive; ensure that you install the
correct definition files for your deployment.

The difference between the two versions is that the files intended for BMC Remedy version 7.6.04 have been exported as
custom objects. The "pre7604" versions can be imported into BMC Remedy 7.6.04, but they will be created as origin objects
and therefore not identifiable as customizations to a standard deployment. The "7604" versions of the definition files cannot
be installed in previous versions of BMC Remedy.

To import the workflow definition files:

1. Log in to the BMC Remedy Developer Studio, and then select File > Import.
2. Select BMC Remedy Developer Studio > Object Definitions, and then click Next.
3. Select the AR System server into which you want to upload the integration objects, and then click Next.
4. Do one of the following:

l Type in the location of the xm_foundation_<version>.def file.
l Click the Browse button to the right of the text field and navigate to the location of the xm_foundation_

<version>.def file. Select the file, and then click Open.
5. Click Next.

l If you have already imported a workflow definition file, ensure that you select the Replace Objects on the
Destination Server check box (do not select the other check boxes), but note that any changes you have made to
those objects will be lost. If you are sure the changes you made are necessary for your installation, you will be
required to re-apply those changes to the new version of the files being imported unless you applied those
changes to overlay objects.

6. Repeat the above steps to import the xm_dataload_<version>.def file.
l Note that this file must be imported after the foundation file.

7. Click Finish.

2.2.2 Configuring filters
The integration includes a filter and an escalation that use the Set Fields action to consume a web service; these objects need
their endpoints changed to the address of the integration agent.

Filter:

n XM:EI:DataLoadInjection_150

Escalation:

n XM:DataLoad Injection Retry

For more information about changing these endpoints, consult your BMC Remedy administrator, or refer to the BMC Remedy
documentation.

BMC Remedy version 7.5 Deployments
Note that BMC Remedy version 7.5 deployments require an additional configuration step, as described in the following
section.

Located in the same directory as the *_pre7604.def workflow definition files is the apia_http_bmcremedy.wsdl file,
which is required by BMC Remedy 7.5 to set the correct endpoint for the filters and escalations.

To update the endpoints, open the WSDL file in a text editor and locate the following element (near or at the bottom of the
file):
<soap:address location="http://localhost:8081/http/bmcremedydataload_bmcremedydataload"/>

Change the addresses within the element to point to the correct address of the integration agent, and save and close the file.
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To load the new values into BMC Remedy version 7.5:

1. Open the filter and escalation in the Remedy Developer Studio tool.
2. In the web service Set Fields action (the second one displayed), edit the WSDL File field to point to the apia_http_

bmcremedy.wsdl file that was just edited. (If the field already contains a value, ensure that it is referencing the correct
file and location.)

3. Click Reload .
l Note that this causes BMC Remedy to reset the rest of the Set Fields action definition.

4. For the filter XM:EI:DataLoadInjection_150 and the escalation XM:DataLoad Injection Retry:
l For the Port field select apia_http_bmcRemedyDataLoadSOAP
l For the Operation field select triggerDataLoad

5. The Input and Output Mappings also need to be recreated for all objects:
l action should be set to Action
l id should be set to ID
l requestType should be set to Request Type
l status should be set to Status
l description should be set to Short Description

6. Save the objects.

2.2.3 Configuring ITSM user
The integration agent requires a dedicated ITSM user to interact with user and group data.

Create an ITSM user
First, create a new ITSM user with permissions to view CTM:People, CTM:Support Group and CTM:Support Group
Associations in BMC Remedy; the user does not need to be Support Staff. For example, you could give the user the 'Contact
People User' permission, or you can reuse the user from another xMatters - BMC Remedy integration.

Note: If you specify a Login ID of "xmatters" for this ITSM user, you can skip the following steps .

Update the default assignee
The out-of-box permissions allow the Submitter and Assignee (and BMC Remedy administrators) to search instances of the
XM:Event Injection form. This allows users who modify users or groups to see the corresponding XM:Event Injection
instance for their update. To allow the ITSM user to also see all of the Event Injection forms, modify the default value for the
Assigned To field to the ITSM user you created.



Chapter 2: Installation and Configuration

11

2.3 Configuring xMatters
Configuring xMatters to combine with BMC Remedy requires the following steps:

n Import the Event Domain and define the integration service
n Configure the Web Services User

2.3.1 Importing Event Domain and scripts
The integration package includes an XML file that was created using the xMatters "Export Integration" feature; this greatly
simplifies the xMatters configuration process by enabling you to create the integration Event Domain, configure the
predicates and Event Domain Constants, and import the integration script package in a single step.

To import the integration Event Domain package:

1. Log in to xMatters as a Company Administrator, and click the Developer tab.
2. On the Event Domains page, click Import New.
3. On the Import Integration page, click Browse, and then locate the \components\xmatters\event-domain\xM-BMC-

Remedy-DL.xml file extracted from the integration archive.
4. Click Open, and then click Upload.

xMatters imports the integration configuration settings and displays the new "bmcremedydataload" Event Domain. xMatters
also creates the predicates for the Event Domain, and assigns common values as defaults. For more information about the
created predicates, and instructions on how to modify them, see "Defining Event Domain predicates" on page 26.

Defining the integration service
For the installation to be successful, the integration service name must match the name specified in the
bmcremedydataload.xml file installed on the integration agent.
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To define an Integration Service:

1. In xMatters, on the Event Domains page, click the bmcremedydataload Event Domain.
2. On the Event Domain Details page, in the Integration Services area, click Add New.
3. Enter the following information into the form:

l Name: bmcremedydataload
l Description: BMC Remedy Data Load Integration Service
l Path: Not required. (This field is used by the xMatters mobile access component, which is not included in this
integration.)

4. Click Save.

Specifying connection parameters
Once you have imported the Event Domain package and configured the Integration Service, you must specify values for the
Event Domain Constants.

Note: A known issue in xMatters version 5.0 requires that all Event Domain Constants be defined in UPPERCASE.

To specify the connection constants:

1. On the Event Domains page, in the Domains menu, click Event Domain Constants.
2. In the Event Domain drop-down list, select bmcremedydataload, and then click Continue.

l xMatters displays the pre-configured Event Domain Constants for the integration:
3. In the Event Domain Constants list, specify the correct values for the following constants (click the name of a constant

to edit its value and description):

Constant Name Default Value Description

BESPUSHURL http://localhost:8888/static Used to specify the address of the BES device
server.

MAINLOGO /static/images/xmatters/logos/xmatters_
email.gif

Specifies the location of the xMatters logo
displayed in email notifications.

Note: This field not added as part of the Event
Domain import process; it is required only on
xMatters 4.1 deployments. You must add this
constant using the tools on the Event Domain
Constants page to have the xMatters logo appear
as expected.

Event Domain Constants

Note: For more information about the Event Domain Constants included in the integration and how to configure them to
suit your deployment, see "Defining Event Domain Constants" on page 24.

2.3.2 Adding the Web Service User
This integration requires an xMatters Web Service User with permission to query existing events in xMatters before injecting
a new event. The following steps describe how to configure the default Web Service User, IA_User, for this integration.
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To set up a Web Service User:

1. In xMatters, click the Users tab, and then click Find Web Service Users.
2. On the Find Web Service Users page, click All.
3. In the returned search results, click IA_User.
4. On the Details for IA_User page, confirm that the list of Allowed Web Services includes the following web services; if

any of the following are not listed in the Allowed Web Services list, select them in the Denied Web Services list (Ctrl-
click to select more than one), and then click Add:

l Add Coverage
l Add Device
l Add Group
l Add Team
l Add User
l Delete Group
l Delete Team
l Delete User
l Delete Device
l Find Devices
l Query Group
l Query User
l Update Coverage
l Update Device
l Update Group
l Update Team
l Update User

5. Click Save.

2.4 Configuring data load
This integration supports one-way data load of Users, Devices, Support Groups, and Support Group Associations from BMC
Remedy to xMatters. When one of these objects is created, modified, or deleted in BMC Remedy, the change is propagated to
xMatters.

To configure the data load process for your deployment, modify the configuration files included with your deployment; the
following sections provide an overview and technical description of this process.

2.4.1 Data load configuration files
The data load configuration files are installed to <IAHOME>\integrationservices\bmcremedy\bmcremedydataload\ as
described in "Installing the integration service" on page 7, and consist of the following files:

n configuration.js: defines the default values for objects loaded into xMatters, and controls the logging of data load
result.

n dataSyncList.js: defines whether the data load will update existing objects or only add new objects, and specifies
the list of included or excluded objects (referred to as the "sync list").

These files define the default values that control the behavior of data load operations; you can modify the behavior of the
data load process by specifying the parameters in the following tables.
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Data load settings: configuration.js file
The following settings can be modified or adjusted in the configuration.js file:

Variable Description Default

XM_CTM_WS_USERNAME Connection information and credentials used to access the BMC Remedy web
services that support the integration; for more information, see "Installing the
integration service" on page 7.

The user chosen here must have a read access to the following forms:

l CTM:People
l CTM:Support Group
l CTM:SupportGroupAssociation

XM_CTM_WS_PASSWORD

MID_TIER_HOSTNAME

MID_TIER_PORT

REMEDY_SERVER_NAME

SEND_SYNC_SUMMARY Determines whether the data load summary should be sent to
the User specified in XMATTERS_ADMINISTRATOR Note
that this summary is written to the integration agent logs.

true

XMATTERS_ADMINISTRATOR The xMatters User ID to which you want to send the data
load summary.

companyadmin

XM_CTM_PEOPLE_WS_BATCH_
QUALIFICATION

Selects a subset of BMC Remedy users for transfer to
xMatters.

XM_CTM_SUPPORT_GROUP_
WS_BATCH_QUALIFICATION

Selects a subset of BMC Remedy groups for transfer to
xMatters.

DEFAULT_SUPERVISOR The xMatters User ID of the default supervisor for Users and
Groups in xMatters.

companyadmin

DEFAULT_XMATTERS_ROLES The default Roles assigned to Users in xMatters. Standard User

MAP_REMEDY_USER_ROLES If this variable is false, all xMatters Users will be assigned
the Role or Roles defined by DEFAULT_XMATTERS_
ROLES, irrespective of what BMC Remedy roles the
individual users have.

If true, the xMatters Roles assigned to individual Users will
be based on their roles inBMC Remedy and the role
mappings defined by the roleMap variable.

false

DEFAULT_USER_SITE Determines the Site to which any new xMatters User should
belong.

Default Site

EXTERNALLY_OWN_USERS Determines whether Users created in xMatters should be
marked as "Externally Owned".

false

EXTERNALLY_OWN_GROUPS Determines whether Groups created in xMatters should be
marked as "Externally Owned".

false

WEB_LOGIN_TYPE Specifies the method of web login to use for Users created in
xMatters; possible values are "NATIVE" (uses xMatters web
login credentials) or "LDAP".

NATIVE
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Variable Description Default

WEB_LOGIN_LDAP_DOMAIN Specifies the LDAP domain to use if WEB_LOGIN_TYPE is
set to "LDAP".

company.com

roleMap If MAP_REMEDY_USER_ROLES is set to true, this setting
specifies how to map BMC Remedy support groups
functional roles to xMatters Roles.

countryCodes Associates international country dialing prefixes with ISO
3166-1 alpha-2 codes required by xMatters.

The default
mapping converts
a dialing code of
"1" to the country
code "US"

Data load settings: dataSyncList.js file
The following settings can be modified or adjusted in the dataSyncList.js file; for more information about these settings
and how they interrelate, see the following section, "Data load process":

Variable Description

SYNC_ACTION Defines whether the Users and Groups specified in the syncList parameter
(defined below) should be included or excluded in the data load.

USER_SEED_ONLY If set to true, user objects will be added to xMatters only when they are initially
loaded, and not updated. If set to false, any modifications to the object in BMC
Remedy will be synchronized with the object in xMatters, overwriting any
changes that may have been made to the object in xMatters.

GROUP_SEED_ONLY If set to true, group objects will be added to xMatters only when they are initially
loaded, and not updated. If set to false, any modifications to the object in BMC
Remedy will be synchronized with the object in xMatters, overwriting any
changes that may have been made to the object in xMatters. Note that the update
process will preserve existing xMatters Team information, such as type and
rotation settings, and the rotation order and delay settings for existing members.

syncList An XML document defining user and group names that should be excluded or
included, as explained in the following sections.

2.4.2 Data priority and sources
The data load integration service uses the following rules for creating and updating the individual properties of Users,
Groups, and Teams in xMatters:

1. New objects are created from a combination of BMC Remedy object information and configured defaults provided by
the integration service file.

2. When an object in BMC Remedy is changed and the corresponding User or Group in xMatters is updated:
l Any properties that are populated with information from BMC Remedy will be updated based on BMC Remedy

information even if the property has been changed in xMatters.
l Any properties that are populated with configured defaults will not be updated, and any changes in xMatters will

be preserved.
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Note: It may take up to five minutes for Users in xMatters to be removed from the database after you remove them from
the system.

The following tables describe the source for the data used to populate the fields Users, Groups and Devices in xMatters.

User data
The data for user details in xMatters that is obtained from BMC Remedy is provided by the XM_CTM_People_WS web
service which exposes fields belonging to CTM:People.

xMatters Field Source

Active BMC Remedy: Profile_Status

User ID BMC Remedy: Remedy_Login_ID

First Name BMC Remedy: First_Name

Last Name BMC Remedy: Last_Name

User Devices BMC Remedy

Roles Configuration file OR BMC Remedy Support group functional roles

Note: Role information is sent to xMatters only when a user record is initially synchronized. The
information is not sent if the user record is modified after the initial sync.

User Site Configuration file

Supervisors Configuration file

Externally
Owned

Configuration file

Web Login
Type

Configuration file

LDAP Domain Configuration file

Group data
The data for group details in xMatters that is obtained from BMC Remedy is provided by the XM_CTM_Support_Group_WS
web service which exposes fields belonging to CTM:Support Group.

xMatters Field Source

Group Name BMC Remedy: the xMatters Group Name is constructed as <Company>*<Support_
Organization>*<Support_Group_Name>

Active BMC Remedy: Status (the xMatters Group is marked as active if the Status is "Enabled")

Description BMC Remedy: Description

Externally Owned Configuration file
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User Devices
The data for device details in xMatters is provided by the XM_CTM_People_WS web service which exposes fields
belonging to CTM:People.

Note: For these Devices to be loaded, you may need to add the Device Names into xMatters. For more information about
adding Device Types and Device Names, see the xMatters installation and administration guide.

xMatters Device Name xMatters Device Type BMC Remedy Field

Work Email Email Internet_Email

Work Phone Voice Phone_Number_Business

Mobile Phone Voice Phone_Number_Mobile

Home Phone Voice Phone_Number_Home

Other Phone Voice Phone_Number_Fax

Numeric Pager Pager Phone_Number_Pager

Note that the data load uses the following rules when processing phone number information from BMC Remedy:

1. The integration uses the country code, area code, number, and extension fields from BMC Remedy to populate the
xMatters Device information.

2. The number field is required, and the device will not be transferred to xMatters if the number is not specified. All other
fields are optional.

3. The BMC Remedy fields are used as is; invalid characters (such as "(" and ")") are not removed. The fields must contain
values acceptable to xMatters, or the Device may not work even if the transfer succeeds.

4. The BMC Remedy country code / numeric dialing prefix is converted to an xMatters Country Code Override that uses
the two-character codes form the ISO 3166-1 alpha 2 standard, and the mappings defined by the countryCodes variable
in configuration.js.

The default integration behavior is to map the dialing prefix 1 to the Country Code Override "US". To change this, or to add
additional mappings, see "Changing country code mapping" on page 31.

2.4.3 Data load process
The data load integration transfers user and group information between BMC Remedy and xMatters in two ways:

n Batch data load: the batch data load happens only when a BMC Remedy user manually initiates the process. You must
create and save a new instance of XM:Event Injection with an Action field value of "Load"; this instructs the
integration to retrieve lists of qualifying users and groups from BMC Remedy and transfer them to xMatters one at a
time.

n Dynamic data load: The integration automatically triggers dynamic data load operations whenever users and groups are
created or updated in BMC Remedy. In this case, the integration is instructed which object to process, and retrieves the
necessary information from BMC Remedy to update the matching object in xMatters.

In both cases, the communication between BMC Remedy and xMatters takes the form of a SOAP web service request. The
integration retrieves information from BMC Remedy using web services provided by the integration (as described in "Custom
web services" on page 2).

The rules which govern the data load process are the same for batch and dynamic operations, with the following exceptions:
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n The batch operation processes only those users and groups that meet the qualification criteria defined in the
configuration.js files described in the preceding section. Dynamic updates will process any user or group for which
BMC Remedy sends a request. If this user or group does not meet the batch qualification criteria, they will be processed
and may result in an update to an existing xMatters User, but will not be added if they do not already exist.

n The batch operation will only add new or update existing Users and Group. The dynamic process can also delete Users
and Groups from xMatters.

The following sections explain the data load process in more detail.

Batch user data load
The USER_SEED_ONLY variable determines how users are treated when loading them into xMatters:

If the USER_SEED_ONLY variable is set to true:

n If (User ID does not exist in xMatters) AND (User meets Batch Qualification criteria) AND [(User ID is not in excluded
list) OR (User ID is in included list)]:

l New User is created in xMatters
l User information is populated
l User Devices are added to xMatters

n IF (User ID already exists in xMatters):
l No changes are made to any Users or Devices

If the USER_SEED_ONLY variable is set to false:

n If (User ID does not exist in xMatters) AND (User meets Batch Qualification criteria) AND [(User ID is not in excluded
list) OR (User ID is in included list)]:

l New User is created in xMatters
l User information is populated
l User Devices are added to xMatters

n IF (User ID already exists in xMatters):
l User information is updated
l User Devices are added to match settings in BMC Remedy

Dynamic user data load
The dynamic data load follows the same behavior defined above for batch data loads, with the following additions:

If USER_SEED_ONLY is set to false:

n IF the request from BMC Remedy indicates that the user has been deleted:
l The User is deleted from xMatters
l User is removed from any Team memberships

n IF (the user is updated) AND (User already exists in xMatters) AND (user currently does not meet Batch Qualification
criteria:

l User will be updated in xMatters
n IF (the user is updated) AND (User ID does not exist in xMatters) AND (user currently does not meet Batch

Qualification criteria):
l Nothing is changed or updated
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Usage notes:

Dynamic updates to Users do not result in the integration service updating their Group associations. For example, if a user is
updated in BMC Remedy and newly qualifies for inclusion in xMatters, their group memberships will not be reviewed, with
the result that they will not be added to any xMatters Groups associated with the BMC Remedy groups to which they
belong.

When a BMC Remedy user who previously has not met the batch update qualification and does not exist in xMatters is
updated and added to a BMC Remedy support group for the first time, the resulting update to xMatters will not add them to
a corresponding xMatters Group. In this case the User must be manually added to the Group in xMatters.

The integration is not able to change the User ID of xMatters Users. If a Login ID of a user in Remedy is changed, the
resulting update to xMatters will create a new User and leave the original xMatters User unchanged.

Batch group data load
The GROUP_SEED_ONLY variable determines how groups are treated when loading them into xMatters:

If the GROUP_SEED_ONLY variable is set to true:

n If (Group name does not exist in xMatters) AND (Group meets Batch Qualification criteria) AND [(Group name is not
in excluded list) OR (Group name is in included list)]:

l New Group is created in xMatters
l Group attributes are added
l Coverage is created
l Team is created

n IF (Group name already exists in xMatters):
l No changes are made

If the GROUP_SEED_ONLY variable is set to false:

n If (Group name does not exist in xMatters) AND (Group meets Batch Qualification criteria) AND [(Group name is not
in excluded list) OR (Group name is in included list)]:

l New Group is created in xMatters
l Group attributes are added
l Coverage is created
l Team is created

n IF (Group name already exists in xMatters):
l Group attributes are updated
l Team membership is updated (see "Team data load" on page 20)
l Group Coverage is not updated

Notes:

n Group updates may modify team memberships, but will maintain existing xMatters Team information, such as type and
rotation settings, and the rotation order and delay settings for existing members.

n If a BMC Remedy Support group has no members at the time it is transferred to xMatters, a Group will be created with
a Coverage and a Team, but the Team will have no members.

n Renaming Groups via data load is not supported: if you change the name of a BMC Remedy group after the group has
been transferred to xMatters, subsequent batch or dynamic synchronization will create a new Group in xMatters
matching the new name of the BMC Remedy group. The data load will not modify the original xMatters Group, and
the new Group will not have any Coverages that may have been added to the original Group.
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Dynamic group data load
The dynamic group data load follows the same behavior defined above for batch data loads, with the following additions:

If GROUP_SEED_ONLY is set to false:

n IF the request from BMC Remedy indicates that the group has been deleted:
l The Group is deleted from xMatters

n IF (the group is updated) AND (Group name already exists in xMatters) AND (group currently does not meet Batch
Qualification criteria:

l The Group will be updated in xMatters
n IF (the group is updated) AND (Group name does not exist in xMatters) AND (group currently does not meet Batch

Qualification criteria):
l Nothing is changed or updated

Team data load
Team membership is updated in xMatters only as part of a batch or dynamic update of BMC Remedy Support groups; the
following sections are included to provide detail on the process.

Note: Team data load behavior is the same for both batch and dynamic synchronizations.

If the GROUP_SEED_ONLY variable is set to true:

n If (Group name does not exist in xMatters):
l New Team will be created in xMatters with the name "<GroupName> - Default Team"
l The Team is associated with a default 24x7 Coverage
n New Team will comprise only those Users in xMatters who are members of the group in BMC Remedy AND for

whom "Assignment Availability" equals "Yes"

n IF (Group name already exists in xMatters):
l No changes are made

If the GROUP_SEED_ONLY variable is set to false:

n If (Group name does not exist in xMatters):
l New Team will be created in xMatters with the name "<GroupName> - Default Team"
l The Team is associated with a default 24x7 Coverage
n New Team will comprise only those Users in xMatters who are members of the group in BMC Remedy AND for

whom "Assignment Availability" equals "Yes"

n IF (Group name already exists in xMatters) AND ("<GroupName> - Default Team" already exists in xMatters):
l Any Users in xMatters who are associated with this BMC Remedy group AND for whom "Assignment

Availability" equals Yes AND who are not already in the Team are added to the default Team in the last
position. Team type, member order and escalations are preserved.

n IF (Group name already exists in xMatters) AND ("<GroupName> - Default Team" does not exist in xMatters):
l New Team will be created in xMatters with the name "<GroupName> - Default Team"
l The Team is not associated with any Coverage
n New Team will comprise only those Users in xMatters who are members of the group in BMC Remedy AND for

whom "Assignment Availability" equals "Yes"
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2.4.4 Data load notification and logging
Following each data load operation, a summary of successful, successful with warning, and failed actions is written to the
integration agent logs. You can also use the XMATTERS_ADMINISTRATOR and SEND_SYNC_SUMMARY variables in
the configuration.js file to send a notification containing the summary to a User or Group within xMatters.

Note that the summary notification is FYI-only. No user responses to the notification are supported and the integration does
not support any annotations from the recipients of the notification or from xMatters concerning the delivery of the
notification.
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Chapter 3: Integration Validation
After configuring xMatters and BMC Remedy, you can validate that communication is properly configured. It is
recommended that you start the components in the following order:

l BMC Remedy
l xMatters relevance engine
l xMatters integration agent

Consult the respective user manuals for details on starting these applications.

The following sections will test the combination of xMatters and BMC Remedy for data load communication,
notification delivery and Subscription functionality.

3.1 Validating data load communication
The following validates that communication from BMC Remedy to xMatters is properly configured for data loading.

To test the data load configuration:

1. Review the dataSyncList.js, and ensure that the values of the SYNC_ACTION and syncList variables will
allow a new BMC Remedy user to be added to xMatters.

2. In BMC Remedy, create a new user and assign them an email address to use as a Device. The user must also
have their Support Staff property set to "Yes", and they must belong to at least one Support Group.

3. Log in to the xMatters web user interface, and confirm that a new User has been added, and has an Email
Device with the expected address.

If the new User does not exist in xMatters, check the integration agent logs for a summary detailing any warnings or
failures.

Note: After the user has been synchronized, it is recommended that you set the Email Device’s User Service
Provider to use virtual email. (The default synchronization process sets the email service provider to
"SMTP Email".) Using the Virtual Email service provider may help when troubleshooting problems in later
testing.
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Chapter 4: Optimizing and Extending the Integration
This section describes some of the ways you can optimize or extend the xMatters (data load) engine for BMC
Remedy ITSM integration.

4.1 Manually configuring xMatters
This integration includes an exported version of the xMatters Event Domain that includes a script package, Event
Domain constants and predicates. If you do not want to use this to create and configure the required Event Domain
and Action Scripts, the following sections describe how to manually configure these components.

4.1.1 Importing the script package
This integration includes a set of customized Action Scripts specific to BMC Remedy that must be imported into the
xMatters scripts.

Note: This step requires the xMatters Developer IDE. For installation instructions and more information about
scripting in xMatters, refer to the xMatters Online Developer's Guide.

To import the xMatters Script Package:

1. Launch the IDE, and then configure the database connection.
2. Click Workspace > Import.
3. Select the \components\xmatters\scripts\XM-BMC-Remedy-DL.aps file extracted from the integration zip

file, click Open., and then click OK.
4. When the script has finished importing, click OK.
5. Right-click the BMC Remedy Data Load (BUSINESS) folder, and then select Validate.
6. Right-click the folder again, and then select Check In.
7. In the Create Script Package dialog box, click Create.
8. In the Check In dialog box, click Close.

4.1.2 Configuring the Event Domain
By default this integration is set up to use an Event Domain of “bmcremedydataload”; it is strongly recommended
that you use this Event Domain name. For the integration to be successful, the Event Domain name must match the
value in the integration agent configuration file for the integration service (i.e., the <domain> tag in
bmcremedydataload.xml).

The xMatters relevance engine web server must be running to perform this portion of the integration.

To define an Event Domain:

1. Sign on to xMatters as a Company Administrator, and click the Developer tab.
2. In the Developer menu on the left side of the screen, click Event Domains.
3. On the Event Domains page, click Add New.
4. Enter the following information into the form:

l Name: bmcremedydataload
l Description: BMC Remedy Data Load Integration
l Script Package: BMC Remedy Data Load

5. Click Save.
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Once you have defined the Event Domain, you can add the integration service, as described in "Defining the integration
service" on page 11.

Defining Event Domain Constants
Company Administrators and Developers can create Event Domain Constants that will be available in scripting for all event
objects associated with an Event Domain. This integration uses Event Domain Constants to define custom values for the
integration script package.

The integration script package uses the names of the constants defined in the table below to look up the values; it is strongly
recommended that you use the names specified, or speak to an xMatters client assistance representative before changing these
values.

To add an Event Domain Constant:

1. In xMatters, click the Developer tab, and then, in the menu on the left side of the screen, click Event Domain
Constants.

2. In the Event Domain drop-down list, select bmcremedydataload.
3. On the Event Domain Constants page, click Add New.
4. Define a Constant Name, Value, and Description for the new constant, according to the table below.

l Note that Event Domain Constant names in xMatters version 5.0 MUST be defined in uppercase.
5. Click Save.
6. Repeat the above steps for each of the constants you want to add.

l Note that if the constants are not defined in the web user interface, the scripts will use the values listed in the
Default Values column of the following table.

Note: Shaded rows indicate mandatory settings that are specific to your deployment. You must change the default settings
to match your instance.

Constant Name Default Value Description

BESPUSHURL http://localhost:8888/static Used to specify the address of the BES device server.
Populates the $main.bes_pushurl parameter.

FAILSAFEGROUP Remedy Fail Safe The fail-safe recipient to notify, typically a group.

The fail-safe group identifies the recipient that will
be notified if an event is injected to xMatters
relevance engine and no subscriptions exist that
match the event. Set this constant if you want to
change the failsafe group from Remedy Fail Safe to
another group defined in xMatters.
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Constant Name Default Value Description

FAILSAFE enabled Controls fail-safe functionality, notifying the fail-safe
recipient via EMAIL under certain circumstances;
possible values are:

l enabled: Notify if no subscriptions match or
no notifiable recipients.

l for-subscriptions: Notify if subscription
functionality is enabled AND no subscriptions
match.

l for-recipients: Notify if no notifiable
recipients.

l disabled: Disable fail-safe functionality.

Populates the $fail_safe parameter.

OVERRIDETIMEFRAMES false Override Recipients Device Timeframes.

Populates the $override_timeframes parameter.

USEEMERGENCYDEVICES false Force the use of emergency Devices.

Populates the $use_emergency_devices parameter.

TRACKDELIVERY true Track when each Device is delivered to. Setting this
to false may give a performance advantage, but you
lose any information about whether a delivery was
successful or not.

Populates the $track_delivery parameter.

TRACKSUBSCRIPTIONDELIVERY true Track when each Device is delivered to for
Subscriptions.

Populates the $track_subscriptionDelivery
parameter.

TIMEOUT 259200 Amount of time (in seconds) the event is allowed to
run before timing out. 259200 seconds = 72 hours.

Populates the $main.timeout parameter.

ENABLEHTMLEMAIL true Enables HTML email functionality.

Populates the $main.enable_HTML_Email
parameter.

USELOGO true Set this if you want the logo displayed within
HTML email notifications.

Populates the $main.use_logo parameter.
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Constant Name Default Value Description

MAINLOGO /static/images/logos
/xmatters_email.gif

Indicates the location of the image that will be
displayed in HTML notification.

The default is the location for xMatters version 5.0;
for 4.1 deployments, the image location should be
changed to:

/static/images/xmatters/logos/xmatters_email.gif

DEBUG false Indicates whether to use the debug level for logging
messages.

Populates the $main.debug variable.

ENABLESUBSCRIPTIONS true Indicates whether to enable processing of
Subscriptions on incoming events.

Defining Event Domain predicates
The default Event Domain provided with the integration includes a number of predicates that contain information about the
incoming event. These predicates are created when you import the Event Domain, and assigned common values as defaults.
You can modify or remove the default values to suit your deployment.

You can also use the following steps to add other predicates that you consider important and which you plan to add to the
integration. For more information about predicates, including the available types and how the Important flag works, refer to
the xMatters installation and administration guide.

To define the Event Domain predicates:

1. In xMatters, click the Developer tab.
2. On the Event Domains page, click bmcremedydataload.
3. On the Event Domain Details page, in the Predicates section, add to or modify the following predicates:

Predicate Type Important Description

has_errors List Indicates whether the data load encountered any errors; possible
values are "true" and "false".

Note that the has_errors and has_warnings predicates are provided to
enable administrators and other Users to create subscriptions in
xMatters that will notify them about data load errors or warnings.

has_warnings List Indicates whether the data load encountered any warnings; possible
values are "true" and "false".

Event Domain predicates

4.2 Configuring SSL
This integration supports SSL communication between the integration agent and BMC Remedy and between the integration
agent and xMatters.
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4.2.1 Using self-signed certificates
The SSL support has been configured out of the box to support self-signed certificates. This is not recommended for
production systems due to security reasons, unless you are aware and accepting of the security implications of self-signed
certificates.

To modify the SSL configuration:

1. Open the <IAHOME>\integrationservices\bmcremedy\lib\javascript\webservices\wsutil.js file and
modify the ACCEPT_ANY_CERTIFICATE variable as follows:

l Set to true to use SSL but trust any certificate (including self-signed ones).
l Set to false to accept only Certificate Authority (CA) certified certificates (recommended in production

environments).

4.2.2 Importing certificates
The next step required to enable SSL support is to import the certificate used by the BMC Remedy web server to the cacerts
keystore of the Java Virtual Machine (JVM) bundled with the integration agent.

Using the keytool executable located at <IAHOME>\jre\bin, execute the following command on the integration agent to
import the certificate, replacing the variables with the appropriate values as described in the list below:
keytool -import -alias <your.alias> -file <path>/<certificate>.cer -keystore
<dir>/jre/lib/security/cacerts -storepass <password>

l <your.alias>: an identifier for the certificate within the keystore; for example, you can use the string
"bmcremedydataload".

l <path>: path to the certificate
l <certificate>: the certificate’s file name
l <dir>: the directory in which the integration agent is installed.
l <password>: the password for the cacerts keystore; the default password is "changeit".

If you want to configure SSL support between the integration agent and xMatters, use the above command to import the
trusted certificate for xMatters into the integration agent keystore (for information on setting up SSL in xMatters, consult the
xMatters Community site at http://connect.xMatters.com).

4.2.3 Updating HTTP to HTTPS
The next step is to update the PROTOCOL in the
<IAHOME>\integrationservices\bmcremedy\bmcremedydataload\configuration.js file to use the HTTPS protocol
instead of HTTP.

The modified value should resemble the following:
var PROTOCOL = "https";

Note: For trusted certificates, "localhost" in the MID_TIER_HOSTNAME variable should be replaced with the COMMON
NAME (CN) specified in the certificate and the port should be set to the port specified in the SSL configuration for
BMC Remedy.

To configure the integration agent to use HTTPS when communicating with xMatters:

1. In a text editor, open the <IAHOME>\conf\IAConfig.xml file.
2. Modify the URL for the <primary-servers> and <secondary-servers> elements to use the HTTPS protocol instead of

HTTP; the section should resemble the following:
<primary-servers>
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<!--
| 0 or more URL elements that specify the primary location of each xMatters server's
| RegisterIntegrationAgent Web Service. The URLs must begin with either http:// or https://
| and cannot have a query or fragment component. The URLs must be resolvable from this IA.
+-->
<url>https://localhost:8443/api/services/AlarmPointWebService</url>
</primary-servers>

<!--
| These servers are assumed to be connected to the same xMatters database,
| which can be different than the primary servers' database.
+-->
<secondary-servers>
<!--
| 0 or more URL elements that specify the secondary location of each xMatters server's
| RegisterIntegrationAgent Web Service. The URLs must begin with either http:// or https://
| and cannot have a query or fragment component. The URLs must be resolvable from this IA.
+-->
<url>https://localhost:8443/api/services/AlarmPointWebService</url>
</secondary-servers>

Note: For trusted certificates, "localhost" should be replaced with the COMMON NAME (CN) specified in the certificate
and the port should be set to the port specified in the SSL configuration for the xMatters server.

3. Modify the value for the <service-gateway> element to use SSL; note that the service-gateway host IP must be
resolvable from the xMatters servers:

<service-gateway ssl="true" host="localhost" port="8081"/>

4. Restart the integration agent.

4.2.4 Optional Configuration
The following scenarios illustrate the common configuration options available when using SSL.

Scenario 1
l BMC Remedy certificate: CA-certified
l xMatters certificate: CA-certified

In wsutil.js, set the variable ACCEPT_ANY_CERTIFICATE to false.

This will ensure ALL communication between the integration agent and BMC Remedy and the integration agent and
xMatters uses the appropriate CA certified certificates

Scenario 2
l BMC Remedy certificate: CA-certified
l xMatters certificate: self-signed

In wsutil.js, set the variable ACCEPT_ANY_CERTIFICATE to false.

In xmatterws.js, add the following line at the end of the init() method:
this.ACCEPT_ANY_CERTIFICATE = true;

This will allow communication between the integration agent and xMatters to use self-signed certificates while maintaining
more complete security between the integration agent and BMC Remedy.
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Scenario 3
l BMC Remedy certificate: self-signed
l xMatters certificate: CA-certified

In wsutil.js, set the variable ACCEPT_ANY_CERTIFICATE to true.

In xmatterws.js, add the following line at the end of the init() method:
this.ACCEPT_ANY_CERTIFICATE = false;

This will allow communication between the integration agent and BMC Remedy to use self-signed certificates while
maintaining more complete security between the integration agent and xMatters.

Scenario 4
l BMC Remedy certificate: self-signed
l xMatters certificate: self-signed

In wsutil.js, set the variable ACCEPT_ANY_CERTIFICATE to true.

This will allow ALL communication between the integration agent and BMC Remedy and between the integration agent and
xMatters to use self-signed certificates.

4.3 Altering the duration of events
You can modify the amount of time xMatters will send out notifications for a particular event before it times out by changing
the timeout Event Domain Constant. This constant stores the number of seconds the notifications will be allowed to continue
before timing out.

For example, if you wanted to change the event duration to two hours, you could change the value for the timeout constant
to 259200.

For more information about working with Event Domain Constants, see "Defining Event Domain Constants" on page 24.

4.4 Optimizing the data load integration
The following sections identify some of the ways you can adjust or modify the behavior of the data load integration to best
suit your deployment.

4.4.1 Mapping user roles
The default behavior of the data load integration is to assign the Role defined in the configuration.js file to all xMatters
Users that it creates. For example, the default file uses the following code to assign the "Standard User" Role to all new
xMatters Users:
var DEFAULT_XMATTERS_ROLES = ["Standard User"];

To assign a different Role, or to assign multiple Roles to all new or updated Users, you can modify the value of DEFAULT_
XMATTERS_ROLES to include a comma-delimited list:
var DEFAULT_XMATTERS_ROLES = ["Role 1", "Role 2];

The integration also supports the more flexible assignment of xMatters Roles based on the Support group functional roles
associated with BMC Remedy users.

To map BMC Remedy roles to xMatters Roles:

1. In the configuration.js file, modify the value of the MAP_REMEDY_USER_ROLES variable to true; i.e.:
var MAP_REMEDY_USER_ROLES = true;
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2. In the roleMap section, edit the roleMap lines to reflect the mapping you want to implement; e.g.:
1| var roleMap = [];
2| roleMap["Broadcast Submitter"] = ["Subscription Supervisor"];
3| roleMap["Support Group Admin"] = ["Group Supervisor"];
4| roleMap["Support Group Manager"] = ["Group Supervisor", "Person Supervisor"];
5| roleMap["Support Group Lead"] = ["Person Supervisor"];

Note how line 4, above, allows you to map a single BMC Remedy role to multiple Roles in xMatters. Any number of these
one to many mappings can be specified, but the configuration does not allow you to assign multiple BMC Remedy roles to a
single xMatters Role in a single roleMap entry.

Note: Lines 2 through 5 can be modified, removed, or added to as needed, but do not remove or modify Line 1.

4.4.2 Changing data load default values
The dataload integration service sets the values of some of the properties of xMatters Users, Groups, and Devices to hard-
coded defaults. For example, Users are assigned by default to the "US/Pacific" time zone, and to the "Default Company".

While these defaults are set by code in library functions found in <IAHOME>/integrationservices/lib/javascript/
xmatters, the recommended method of changing the default values is to use the property values available in the integration
service files in <IAHOME>/integrationservices/bmcremedy/bmcremedydataload/.

The following table lists the relevant files and functions; you can view the library javascript files to determine the names of
the object properties.

Object Library File Integration
Service File

Function Details

User dataSyncUser.js processUsers.js makeUserForAddUpdate() Sets User properties after a new
User objects is created by
calling new User()

Device dataSyncDevice.js processUsers.js makeUserForAddUpdate() Sets property values for Devices
other than Voice and Pager

phonenumber.js setVoicePhoneOrPager() Sets property values for Voice
and Pager Devices

Group dataSyncGroup.js processGroups.js makeGroupForAddUpdate
()

Sets Group properties after a
new Group is created by calling
new Group()

Team dataSyncGroup.js processGroups.js makeGroupForAddUpdate
()

Sets the property values for the
Team created for Group objects

Team
Member

dataSyncGroupMember.js processGroups.js makeGroupForAddUpdate
()

Sets the properties for Team
members after new
GroupMember() is called

4.4.3 Changing user device mapping
The makeUserForAddUpdate() function within the processUsers.js file examines the remedyPerson object that describes
the user details in BMC Remedy, and maps the user devices to xMatters. The code that does this for a given device is a
code block that typically resembles the following:
syncDevice = new EmailDevice(user.targetName, "Work Email");
syncDevice.isDelete = isEmpty(remedyDeviceInfo);
syncDevice.address = String(remedyDeviceInfo);
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syncDevice.externallyOwned = user.externallyOwned;
user.devices.add(syncDevice);

To change the mappings between devices in BMC Remedy and Devices in xMatters, including a change to the name of the
xMatters Device, add to or edit the relevant code block for the Device as needed.

4.4.4 Changing country code mapping
When the data load integration creates a Voice Device in xMatters, the integration transfers the country code (CC), area code
(Area), local number (Number), and extension (Extension) fields from BMC Remedy to the corresponding fields in xMatters.

The integration assumes that the CC field in BMC Remedy, if it is not empty, contains a numeric country dialing prefix, or
the North American long-distance prefix of '1'. This value is mapped to the ISO 3166-1 two-character country code that
xMatters uses for the Country Code Override field.

The mapping from dialing prefix to Country Code Override is defined by the countryCodes variable in the configuration.js
file:
var countryCodes =
<countryCodes>
<country>
<dialingPrefix>1</dialingPrefix>
<ISO_3166_1>US</ISO_3166_1>

</country>
</countryCodes>

You can extend the default configuration by adding <country> elements to the above definition. Note that each <country>
element defines a one-to-one mapping. If more than one mapping uses the same dialing prefix (e.g., US and CA are both
associated with the dialing prefix "1", the integration will use the first mapping it finds.

4.5 Constructing BES and email notifications
You can configure xMatters to create BES and HTML email notifications.

This feature requires the xMatters Developer IDE. For installation instructions, refer to the xMatters Online Developer's
Guide.

To enable BES and HTML email, the BMC Remedy Data Load (Business) script package set must be checked into the
Developer IDE Database. If the script package has not been checked in already, see the instructions in "Importing the script
package" on page 23.

Note: Some email clients, such as Microsoft Outlook 2007, may not display HTML elements correctly. It is recommended
that you test the HTML compatibility of your email client before implementing the HTML email feature.

To enable BES and/or HTML email:

1. In xMatters, click the Developer tab, and then, in the menu on the left side of the screen, click Event Domain
Constants.

2. In the Event Domain drop-down list, select bmcremedydataload.
3. On the Event Domain Constants page, do the following:

l Set the ENABLEHTML constant to true.
l Set the USELOGO constant to true (if you want your HTML email to show a logo).
l If you are using BES, set the BESPUSHURL constant to the URL of the BES server.

Note: If the Event Domain Constants are not present, you can add them using the names specified above. For more
information, see "Defining Event Domain Constants" on page 24.
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4. Optionally, you can also use the Developer IDE to make any of the following changes to the Global Configuration
Variables section of the initial PROCESS script in the BMC Remedy Data Load (Business) Production script package::

l Set $main.logo_alt_text to the text you wish to display when the logo cannot be fetched. This can be
displayed if the email client is configured not to show images, or it could be displayed because the email client
cannot access the xMatters web server directly and thus cannot respond by using the links in the HTML.

5. Save and validate the script, and check in the script package.

For more information about these and other configuration variables, see “Configuration Variable Reference” on page 55.

4.6 Uninstalling
For instructions on removing an xMatters deployment, refer to the xMatters installation and administration guide.

To remove the BMC Remedy objects installed as part of this integration:

1. Open the BMC Remedy Developer Studio
2. Locate and remove the following packing lists:

l XM:Foundation Packing List
l XM:DataLoad Packing List

These list all of the objects that are part of the integration. Deleting the objects contained in these lists, and the lists
themselves, removes all objects imported into BMC Remedy as part of this integration.
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Chapter 5: Configuration Variable Reference
This section outlines and describes the configuration variables available in the initial PROCESS Action Script.

Note that many of the configuration variables are configurable using the Event Domain Constants, as described in
"Defining Event Domain Constants" on page 24; those variables are not listed here.

5.1 Global configuration variables
These variables are available throughout the script package, and are parameters of the “main” object. The value
assigned to each variable is its default value within the script.

Variable Description

$main.use_logFile = false Specify whether to use an alternate log file for debugging
messages. This variable is ignored unless $main.debug is
also set to true.

$main.logFile = "../logs/" Defines the file used to log debugging information (only if
$main.use_logfile is set to true).

$main.logo = $main.xmatters_url &
"/static/images/logos/xmatters_email.gif"

Specifies the path to the graphic displayed on HTML (email
and BES) notifications.

Note: For xMatters 4.1 deployments, the path should be
changed to:
/static/images/xmatters/logos/xmatters_
email.gif

$main.logo_alt_text = “[If the logo does not
appear you may be blocking images or you may
be outside a firewall. If the latter, the links will
not work for responding and you should respond
by replying to this email as described below.]”

The alternate text to display if the HTML email logo is
unavailable.

Note: If the logo does not display, it is unlikely that the
HTML_form_url is valid and responses will not be injected
from HTML Devices (email and BES).

$main.numeric_pager_number = “555-1212” The phone number to display for calling in to retrieve event
information. This variable has a non-existent number as a
default value; a real call-in number must be supplied, or a
message indicating that an xMatters event has occurred.

Gobal variables

5.2 Local Configuration Variable
These variables are available only in this script, and control how the script runs. For more information about the
initial PROCESS script, consult the xMatters Online Developer's Guide.

5.2.1 FYI and Subscription Notification Variables
The following variables configure the behavior of informational-only, or FYI, notifications. The value assigned to
each variable is the default value within the script.
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Variable Description

$use_email_for_fyi = true

$use_phone_for_fyi = false

$use_im_for_fyi = true

$use_text_phone_for_fyi = true

$use_text_pager_for_fyi = true

$use_numeric_pager_for_fyi = true

$use_bes_for_fyi = true

$use_generic_for_fyi = true

Configure Device filters for informational-only (FYI) notifications.

Setting these flags to false prevents that Device type from being notified with
informational (FYI) messages.

FYI and Subscription variables
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